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Abstract 

Sentinel-1 SAR data preprocessing is essential for several earth observation applications, including 
land cover classification, change detection, vegetation monitoring, urban growth, natural hazards, 
etc. The information can be extracted from the 2x2 covariance matrix [C2] of Sentinel-1 dual-pol (VV-
VH) acquisitions. To generate the covariance matrix from Sentinel-1 single look complex (SLC) data, 
several preprocessing steps are required. The ESA SNAP S-1 toolbox can be used to preprocess the 
data to generate a [C2] matrix. The polarimetric analysis in respective application fields often starts 
with the covariance matrix. However, due to limited availability of Sentinel-1 SLC data preprocessing 
workflow standards for polarimetric applications in contemporary research methods, downstream 
applications unable to comply with these workflows directly. In this paper, we propose a couple of 
generic practices to preprocess Sentinel-1 SLC data in SNAP S-1 toolbox, which would be beneficial 
for the radar remote sensing user community. 

 Single and multi-date data preprocessing workflow for Sentinel-1 
 A generic workflow to obtain dual-pol covariance matrix elements from SLC products 
 Accurate sub-pixel level coregistration of multi-date data 
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1. Introduction 

Synthetic Aperture Radar (SAR) data in dual polarimetric mode (HH-HV or VV-VH) is widely used in 
the radar remote sensing community due to its high spatio-temporal coverage. However, compared 
to a full-pol system, the information content retrieved from a dual-pol system partially characterize 
a target [1]. Nonetheless, the potential and operational scalability of dual-pol data in various fields 
such as crop monitoring [2], [3], soil moisture [4], forest biomass [5], land cover  classification [6], 
[7], natural disaster [8] is reported with promising accuracy and reliability. Global data availability 
and open access data policies of Sentinel-1 A/B dual-pol SAR system lead to the development of 
operational scale applications [9].  
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Much effort has capitalized in the last few years to preprocess Sentinel-1 data for interferometric 
applications. Majority of the polarimetric studies with Sentinel-1 concentrated on the analysis of 
backscattered intensities (𝜎𝑉𝑉

0  and 𝜎𝑉𝐻
0 ) or the ratio of backscattered powers [10], [11]. The phase 

information between the two orthogonally polarized channels (V and H) is inadvertently ignored in 
these studies. Both the power and phase information is essential to characterize the target in the 
backscatter field, and forms the rationale behind identifying elementary scatterers in dual-pol mode 
[12]. The polarimetric information of a target can be represented in form of a 2x2 covariance matrix 
([C2]), which would be helpful for polarimetric analysis. A very few studies indicated the potential of  
using polarimetric information from [C2] for several applications [13], [14]. 

To generate a covariance matrix from Sentinel-1 single look complex (SLC) data, several 
preprocessing steps are involved, which require special attention. European Space Agency (ESA) 
provides SNAP Sentinel-1 toolbox for processing of these datasets [15]. The toolbox includes several 
modules for radiometric calibration, coregistration, Sentinel-1 TOPS processing, polarimetry and 
interferometry, despeckle, geometric correction, etc. [16]. A wide range of end-users requires 
analysis-ready data (ARD) products (e.g., [C2] matrix elements) for polarimetric analysis with a 
standard set of corrections and preprocessing workflow. However, there is no standard workflow 
available in contemporary research methods for preprocessing of Sentinel-1 SLC data for 
polarimetric applications. In the present method, we propose a couple of generic practices to 
preprocess Sentinel-1 SLC data in SNAP S-1 toolbox, which would be beneficial for the radar remote 
sensing user community. The proposed workflows produce a polarimetric matrix from preprocessed 
Sentinel-1 data, offering a benchmark for the improvement of existing practices. 

 

2. Imaging geometry and the toolbox 

2.1. Sentinel-1 imaging geometry 

Sentinel-1 is a constellation of two satellites (1A and 1B) operating in C- band. The constellation 
reduces the repeat frequency of the satellites from 12 to 6 days; making the data more useful for 
interferometric and polarimetric applications [9], [17]. Interferometric Wide swath (IW) is one of 
the acquisition modes of Sentinel-1 capturing data over the land surface. In this mode, three 
subswaths (IW1, IW2, and IW3) are imaged using Terrain Observation with Progressive Scans SAR 
(TOPSAR) technique with a spatial resolution of 5 x 20 m [18]. The IW products are delivered in form 
of slices to make the data more manageable in terms of storage and computational effort. Each slice 
is a stand-alone product and can be processed independently. Each slice covers approximately 250 x 
150 km in range and azimuth direction. The nomenclature of each subswath is based on the orbit 
type, i.e. ascending or descending. The subswath close to the near range is IW1, and the subswath in 
the far range is IW3. Each subswath consists of nine bursts in the azimuth direction. The individually 
focused complex bursts are arranged in azimuth-time order with the black-fill demarcation between 
them. Figure 1 represents the imaging geometry of a descending pass Sentinel-1 IW product.  

  

2.2. SNAP Sentinel-1 toolbox 

The Sentinel-1 toolbox (S1TBX) is part of the SNAP software, which supports reading, displaying, 
processing and writing of data from various remote sensing satellites such as ERS, ENVISAT, Sentinel-
1, RADARSAT-1 & 2, PALSAR-1 & 2, TerraSAR-X, TanDEM-X, COSMO-SkyMed, etc. The toolbox 
includes several polarimetric and interferometric tools for calibration, coregistration, speckle 
filtering, subswath merge, subset, multilook and data conversion, etc. The Sentinel-1 toolbox along 
with other toolboxes (Sentinel-2, Sentinel-3, SMOS, and Proba-V) is widely used by researchers in 
the field of satellite remote sensing. 
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Figure 1: Sentinel-1 descending pass imaging geometry. The red and black rectangles show two individual 
TOPSAR slices. Each slice has three interferometric wide subswaths (IW1, IW2, and IW3) in range direction 
and each subswath has nine bursts in the azimuth direction.  

 

3. Data processing workflows 

In this paper, we describe two essential workflows for Sentinel-1 SLC preprocessing for generating 
polarimetric matrices. The workflows are 1) Single-date data processing, and 2) Multi-date data 
processing. These workflows are well tested and computationally efficient. As the name suggests, the 
first workflow deals with a single data product acquired on a specific date over an area of interest 
(AOI). However, in the case of temporal analysis or change detection studies, we often perform multi-
date data processing over an area of interest. Therefore, the second workflow is designed to consider 
several images, which need to be coregistered to produce accurate and reliable results. In addition to 
the single or multi-date processing, we describe the processing strategy for three different situations 
based on the location of AOI.   

3.1. Single-date data processing  

For a single date, the data processing is divided into three categories based on the location of AOI and 
its coverage by the product swath, as shown in Figure 2. Based on the Sentinel-1 product geometry 
the categories are: (1) single subswath processing (e.g., IW1 of Slice2) (2) multiple subswath 
processing (e.g., IW1 and IW2 of Slice2) and (3) assembly of two slices (e.g., IW2 from Slice 1 and 2). 

 

Figure 2: Three main categories of data processing based on the location of users area of interest (AOI). (a) 
single subswath (b) multiple subswath and (c) assembly of two slices. 
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3.1.1. Category 1: Single swath processing 

For a single subswath (e.g., IW1 of Slice2) processing, the data processing workflow is shown in 
Figure 3. The workflow consists of four modules. In Module 1, individual Sentinel-1 images are read 
into the SNAP software, split, a precise/restituted orbit file is applied to update the state vectors, and 
the image is calibrated. During calibration, it is important to save the output product in complex 
format. A complex output is necessary to generate a polarimetric matrix in further steps. All the four 
steps in Module 1 are to be performed individually on each Sentinel-1 image. To save time and to 
automate the operation, we suggest the user build a graph for Module 1 steps and process. Later, 
Module 2, 3, and 4 steps are executed one by one to complete single-date data processing. The 
operators used in these modules are explained in Table 1. We have provided sample graphs for single 
and multi-date data processing of a single subswath in the resources link. A user can customize these 
graphs (.xml files) to suit their processing needs.  

 

Figure 3: A module-wise flowchart for polarimetric matrix generation. All steps are designed to be performed 
on a single or a set of images. The steps highlighted in blue are only applicable for multi-date data processing, 
as described in Section 3.2. The steps indicated by * require manual operation by the user. In the case of multi-
date data processing, all the steps in Module 1 and the last step in Module 4 is to be performed on individual 
products.  

 

3.1.2. Category 2: Multi subswath processing 

Depending upon the category of data processing, we made necessary changes in a specific module, 
which is to be replaced with an existing module in Figure 3. In case of multiple subswath processing 
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(e.g., IW1 and IW2 of Slice2), Module 2 is modified as shown in Figure 4 , which includes the S1-TOPS 
Merge operator. This operator merges debursted split products of different subswaths into a single 
image. 

 

Figure 4: Modification in Module 2 for processing multiple subswaths. Note that S-1 TOPS Merge operator 
requires input from at least two splits.  

 

3.1.3. Category 3: Assembly of two slices 

In case of the multiple slice processing of a single date (e.g.: IW2 of Slice 2 and Slice1), Module 1 is 
modified as shown in Figure 5. The Slice Assembly operator merges two or more slices from different 
products of an orbit. For example, if AOI lies in between IW2 of Slice 1 and Slice 2 (refer Figure 2c), 
the Slice Assembly operator assembles the subswaths of different slices of an orbit into a single 
product. 

 

Figure 5: Modification in Module 1 for processing multiple slices. 

 

Module 3 and 4 are the same for the above three processing categories. Module 3 initiates the 
polarimetric matrix element generation. Here, it is important to note that only 2x2 covariance matrix 
[C2] is possible from dual-pol Sentinel-1 SLC data. In the presence of quad-pol information (e.g., 
RADARSAT-2, ALOS-2) it should be changed to 3x3 covariance [C3] or 3x3 coherency [T3] matrix. 
These matrix elements are processed further by despeckling with any of the speckle filters viz., 
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Boxcar, Lee, Refined Lee, etc. Selecting the window size is users’ choice based on the requirement of 
feature characteristics [19].  The next step includes an optional choice to geocode the product. At this 
step, a user should take care of the projection system, e.g., WGS84 or UTM projected coordinate 
systems. 

At the final step in Module 4, the single date data product is exported to PolSARPro format. It stores 
each matrix elements (C11, C22, C12_real, and C12_imag) individually in a binary format with header 
information. 

 

3.2. Multi-date data processing 

It includes processing of SLC data acquired on different dates over an AOI (Figure 6). The multi-date 
data processing involves coregistration step (S-1 Back Geocoding) from which, a user can generate a 
stack of coregistered data. The interferometric coregistration step coregisters all the SLC images with 
sub-pixel level accuracy, which is necessary to produce accurate and reliable results. In the afore-
mentioned single-date processing categories, the steps marked in blue are intended only for multi-
date data processing. The major difference of this workflow is the co-registration step. 

 

Figure 6: A schematic representation of multi-date images. The AOI represents users area of interest covering 
in a single subswath. 

 

The S-1 Back Geocoding operator in Module 2 is used to coregister multiple SLC images using a digital 
elevation model (DEM) and orbit information. A stack consisting of multiple coregistered SLC images 
is generated after this step. All the bands of an SLC image in the coregistered stack are named based 
on the image acquisition date. The stack is given as an input to the TOPS Deburst operator, which 
merges different bursts of an image into a single SLC image. An optional subset operation can be 
performed on the debursted image to subset the product into a smaller size. A subset operation at 
this stage is computationally efficient as it reduces the data volume. After this, all the steps in Module 
3 are performed on the stacked product. 

Another important step for multi-date data processing is shown in Module 4, which deals with 
baseline information. Due to the implementation of interferometric coregistration, baseline 
information is present in the metadata of the stacked product. The baseline information has to be 
removed to export the data from SNAP to PolSARPro format. Therefore, the user has to manually 
delete the baseline information from the metadata of the stacked product. The stack is then split into 
individual products using Stack Split operator. Later, these products are exported into PolSARPro 
format.  
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Table 1: Descriptions of different operators and selections in the SNAP platform. 

Operator Description Operator location in SNAP 

Read Read Sentinel-1 IW product File > Import > SAR Sensors > 
SENTINEL-1 

S-1 TOPS Split Split each swath with selected bursts into 
a separate product 

Radar > Sentinel-1 TOPS > S-1 
TOPS Split 

S-1 Slice Assembly Merge two or more slices from different 
products of an orbit. For example, IW2 
from Slice1 and Slice2 as shown in Figure 
1. 

Radar > Sentinel-1 TOPS > S-1 
Slice Assembly 

Apply Orbit File Download and apply precise Sentinel-1 
orbits 

Radar > Apply Orbit File 

Calibrate Apply the radiometric correction to SAR 
images so that the pixel values of the SAR 
images truly represent the radar 
backscatter of the reflecting surface. 
Note: Output to complex data at this step. 

Radar > Radiometric > 
Calibrate 

S-1 Back Geocoding Coregister two or more SLC products 
using orbit files and DEM 

Radar > Coregistration > S1 
TOPS Coregistration > S-1 Back 
Geocoding 

S-1 TOPS Deburst Merge bursts in the azimuth direction to 
form a seamless image 

Radar > Sentinel-1 TOPS > S-1 
TOPS Deburst 

S-1 TOPS Merge Merge debursted split products of 
different subswaths into a single image.  

Radar > Sentinel-1 TOPS > S-1 
TOPS Merge 

Subset Subset the image as per area of interest. 
This step is optional. 

Raster > Subset 

Polarimetric Matrix 
Generation 

Generate polarimetric matrix Radar > Polarimetric > 
Polarimetric Matrix Generation 

Multilooking Reduce speckle noise and generate a 
ground range square pixel 

Radar > SAR Utilities > 
Multilooking 

Polarimetric Speckle 
Filter 

Despeckle operation on a polarimetric 
matrix 

Radar > Polarimetric > 
Polarimetric Speckle Filter 

Range Doppler Terrain 
Correction 

Geocode the product. This step is 
optional. 

Radar > Geometric > Terrain 
Correction > Range-Doppler 
Terrain Correction 

Delete baseline 
information 

Delete baselines information manually 
from metadata of stacked product 
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Stack Split Separate a stacked product into 
individual products based on the 
acquisition date 

Radar > Coregistration > Stack 
Tools > Stack Split 

Export Export the individual products to 
PolSARPro format 

File > Export > SAR Formats > 
PolSARPro 

 

4. Summary 

The present study proposes a couple of generic workflows for Sentinel-1 SLC data preprocessing in 
SNAP S-1 toolbox. The essential workflows to generate a polarimetric matrix are 1) Single-date data 
processing, and 2) Multi-date data processing. The modular scheme of these workflows allows the 
user to control the options in each operator. For example, coregistration in rugged terrains can be 
improved by estimating range and azimuth offsets using enhanced spectral diversity (ESD); or 
different polarimetric speckle filters can be chosen based on the heterogeneity of the area. The multi-
date data processing workflow would be of great interest for time series analysis with less error due 
to the coregistration step. The order of the steps in these workflows is efficiently designed to tackle 
the memory and data processing issues. Nevertheless, developing a generic workflow for 
preprocessing steps is important to ensure uniformity across the data sets and results for 
polarimetric applications.  
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